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ABSTRACT

This project examines the use of computer animation in tutorial videos as an 
educational tool within the biology laboratory curriculum and explores the 
methodology for the development of computer animation.  Student reception of the 
tutorials was assessed by survey (BB2903 C09 lab) with both multiple choice and open 
ended questions and the number of “hits” on the media server. Tutorials were found to 
be well received and instructionally beneficial.  Animations were not preferred over live 
action of procedures, thus was recommended for supplementing live action.  
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INTRODUCTION

This Interactive Qualifying Project (IQP) examines the use of computer animation in 
tutorial videos as an educational tool within the laboratory curriculum in the 
Department of Biology & Biotechnology (BB)  and explores the methodology of the 
development and use of such computer generated animation which future teams may 
use, as part of The Connected Laboratory Project currently under development at 
Worcester Polytechnic Institute (WPI).  The goals of the project were to determine the 
best structure for animated content that would facilitate efficient learning, develop a 
method for creating or integrating computer animated content (graphics, movement, 
narration, and music), determine the pitfalls and workarounds future teams would 
need to avoid and follow, to asses the reception of the tutorials in general by students 
and analyze student feedback, and present direction for the future use of animation 
within the Connected Laboratory Project. The reception of these tutorials, both in 
general as an educational tool and specifically for computer animated content, was 
assessed by a survey of BB2903 C09 students with both multiple choice and open ended 
questions and the recording of access request numbers (hits) for the tutorials on the 
media server.  It was found that the tutorials were well accepted by students and were 
instructionally effective.  Students required less assistance from faculty and staff and 
reported feeling more comfortable and confident performing in the lab after watching 
tutorials and having access to them during the session.  Animations were found not to 
be preferred over live action demonstrations of procedure and it was therefore 
recommended that their use be restricted to supplementing live action or in cases where 
live action is inappropriate or impossible (such as demonstrations of molecular 
interaction).  The team found that the development of animations is best accomplished 
with true animation software such as Adobe Flash or the open source Synfig Studio. 

About the Connected Laboratory Project

The Connected Lab Project will provide an opportunity to design a laboratory 
experience that will engage current students to take advantage of novel technologies, 
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including blogs, wikis and podcasts, to gather information. The program will eventually 
be adapted for use with other courses at WPI. Some of the benefits from incorporating 
multimedia and other digital resources and technology include instant access to 
information and instant exchange of data in the teaching labs. Instant access to 
information will bring new efficiency to the current teaching lab, allowing students to 
control the pace at which they work and learn. The main products of this project will 
include digital media to support independent procedural learning in the lab, a process 
that makes it easy for both faculty and students to create and share digital media that 
supports the laboratory experience.

Background: Animation & Learning

Animation, as defined by Rieber & Kini (1991), is a rapid presentation of an image 
series, say, on a computer screen, so as to depict change over time (Hoffler & Leutner, 
2007).  Animation, therefore, could be very useful when presenting information to and 
audience as a change over time which simulates the “real world” and potentially lends 
itself to better understanding by the audience relative to static images (Arguel and 
Jamet, 2009).

Potential Advantages of Animation 

Animation has a host of potential advantages, as it can be made to closely simulate the 
space and time of reality.  The congruence principle, proposed by Tversky et al., (2002), 
states that when the subject an animation presents is very similar to the actual content 
to be learnt, closely simulating reality, it allows learners to better internalize it ( Arguel 
& Jamet, 2009; Schnotz & Bannert, 2003).  The fact that animation can operate with a 
dimension of time, information involving changes over time can be more accurately 
represented with animation as opposed to static figures (Arguel & Jamet, 2009; Tversky 
et al., 2002).  Additionally, animation conveys more information to viewers than a 
simple series of static images would by showing changes that would take place between 
each of the static images and would not require viewers to infer them (Arguel & Jamet, 
2009).  Research has found that animation can be especially effective when depicting 
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human-motor skills, for example, learning to tie knots or complete puzzle rings by 
Ayres et al., (2009) and teaching paper-folding tasks by Wong et al., (2009).  Learning 
human-motor skills in this way is so effective due to a human’s ability to learn actions 
by observing them with the system of mirror-neurons (Ayres et al., 2009).  

Yet, despite these potential advantages, research has often found animation to be no 
more effective than the use of static images (see review by Tversky et al., 2002).  In fact, 
in certain cases, static images were found to be more effective than animation.  Such 
was the finding of research by Mayer et al., (2005), where static diagrams were 
educationally superior to animation when learning about mechanical systems.  In order 
to understand how and when animation may or may not be a more effective learning 
medium, Cognitive Load Theory can help to shed some light on how cognitive 
processes may handle such information.

Animation & Cognitive Load Theory

Cognitive load theory (CLT) is centered on the idea that long term memory (LTM), 
working memory (WM), and the interaction between the two is very important for the 
learning process.  WM is highly limited, both in capacity of information and the 
duration information remains (Miller, 1956; Peterson & Peterson, 1959), and behaves 
something like a temporary buffer for momentary information that the brain is using.  
So, if instructions of any kind ignores the limitations of WM, such as when more new 
information is presented than WM can effectively handle, effectively learning that 
information may not be possible (Ayres & Paas, 2007).

CLT describes three types of load that can affect WM intrinsic, extraneous, and germane 
(see Paas et al., 2003; Sweller et al., 1998). Intrinsic load is caused by the inherent 
complexity of the information input itself (Ayres & Paas, 2007).  The greater the 
complexity of the information presented, the greater the intrinsic load on WM. 
Extraneous load is caused by unclear, poorly designed instructions which require extra 
cognitive effort to sort out in an attempt to understand them (Ayres & Paas, 2007).  
Germane load is the "good" load caused by the active cognitive tasks in place to learn 
and process the novel material (Ayres & Paas, 2007). Learning is impeded when either 
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the intrinsic or extraneous loads are too high and not enough WM resources are 
available to support the necessary germane load. 

With this in mind, the design of animation becomes very important in order to facilitate 
good learning.  A given animation can not be overly complex, with numerous elements 
and excessive motion at any given time, in order to reduce intrinsic load.  The 
instruction it self must be clear and easily understood in order to reduce the extraneous 
load. According to Sweller & Chandler (1994) and Sweller et al. (1998), an animation as 
such would have two essential functions:

•If an animation reduces such loads so as to permit processing tasks, then the 
animation has an enabling function.

•If an animation reduces loads of tasks that, without the animation, would 
require more effort, then the animation has a facilitating function.

By minimizing these two loads imposed my an animation (or any educational material, 
more WM resources may be allocated to the germane load and thus facilitate better 
learning of the material.

Further Explanation for the Relative Ineffectiveness of Animation

Further explanation as for why animations are sometimes relatively ineffective 
compared to static images stems largely from how animations may be used.  The 
congruence principle (Tversky et al., 2002), as described above, indicates that an 
animation depicting content that is not inherently dynamic, or if constructing a dynamic 
internalization of the content is not relevant for learning it, would be no more effective 
that displaying static information and images (Arguel & Jamet, 2009).  In fact, having an 
animation of such material could be detrimental, as it may be more complex or present 
more information than is necessary and raise cognitive load (Arguel & Jamet, 2009; 
Sweller & Chandler, 1994). The dynamic nature of animation can be just as detrimental 
as it is beneficial if non essential elements or material distract viewers from the relevant 
material, forcing viewers to filter out unimportant information themselves and raising 
cognitive load (Ayres & Paas, 2007). 
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The transient nature of animation can also lend it self to insufficient learning of 
material, most especially when important information is on screen for a short amount of 
time before disappearing and new information is presented (see Ainsworth & 
VanLabeke, 2004; Ayres & Paas, 2007).  Rapid succession of material can also put 
unnecessarily heavy loads on WM, especially when trying to remember and integrate 
already past material with present and upcoming material (Arguel & Jamet, 2009).

The evolved mirror-neuron system in the brain may also explain how animations not 
related to human-motor action may not be better suited than static images.  Ayres et al. 
(2009) note:

"If ... humans have evolved to observe movement and copy it (through mirror-
neurons), then asking learners to observe an animation in order to learn a motor 
skill may not place an excessive burden on WM resources, as we have 
biologically evolved to cope with it. In contrast, learning about secondary 
knowledge (see Geary, 2007), such as mechanical systems, or using static 
diagrams to represent human movement, may require more WM resources, 
because we do not have the same biological (neural networks) 
advantages" (Ayres et al., 2009).

Fortunately, taking care in the animation design process can combat some of the 
educational ineffectiveness.

Design Practices to Optimize Learning

First and foremost, designing animations with CLT theory in mind, reducing intrinsic 
and extraneous cognitive load to maximize germane load, should be the primary focus 
in animation designing to facilitate better learning (Chandler, 2004). Taking care to 
reduce unnecessary visual complexity and developing streamlined instruction are the 
first steps optimizing WM resources.  

Maintaining certain key elements on screen for as long as possible without cluttering 
the presentation can help to reduce the negative impact transience can have on learning 
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(Arguel & Jamet, 2009).  Additionally the negative effects of transience can be reduced 
with the use of static images to supplement material in motion (Arguel & Jamet, 2009)

Adding interactivity can also aid in reducing cognitive load caused by transience. 
Access to playback controls allows for users to pause and go back to review information 
that was perhaps missed by the viewer or if the viewer wants to review a section again 
for reinforcement (Betrancourt, 2005; Hasler et al., 2007).  Additionally, dividing the 
presentation into sections, where the presentation may pause at the end of each before 
proceeding, allows viewers to better organize related information which would let WM 
resources "catch up" before proceeding (Arguel & Jamet, 2009). Interestingly, a study by 
Hasler et al. (2007) found that the group of learners with access to playback control 
learnt better than the group without it, though the group rarely used the controls.

Forms of guidance integrated with animated visuals can reduce load by helping 
viewers focus on the most important points.  The use of textual annotations on screen 
can help to highlight essential information (Harp & Mayer, 1998).  Narration provides 
guidance and explanation similarly to text, but does not require the viewer's visual 
diversion from the primary presentation.
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METHODS

The animated tutorials produced for the Connected Laboratory Project at WPI were 
created using Apple iWork ’09 Keynote.  Figure 1 below illustrates the overall process 
for creating any one of the tutorials.  The detailed methodology is described in the 
following subsections.

Figure 1.  Animated Tutorial Development Flow Chart

Script Writing

Step one in the entire process of tutorial development, after a topic had been selected, 
was to begin researching that topic and write the first draft of the script to be used. 
Research primarily involved reviewing laboratory protocol and documentation already 
written by lab faculty. However, sources on the web, such as encyclopedias, online 
tutorials, and published papers, were also consulted. The script primarily consisted of 
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content to be spoken as narration and was written with the rich text editing application 
for Mac OS X named “TextEdit” (Windows homolog: “Wordpad”).  Use of a rich text 
editor was chosen for its basic word processing whilst retaining rich text capabilities 
and universality of file format (Rich Text Format, .rtf).

Storyboard Development

Once the script was written the next step was to develop the visual accompaniment that 
would serve as a template for the animated tutorial's key frames.  The film & television 
industries refer to this process as story-boarding.   The “storyboard” developed for 
these tutorials never involved the creation of an authentic storyboard and instead 
consisted of discussion, brainstorming, and crude sketches.  The first step was to 
develop the overall visual theme used in the tutorial to maintain consistency.  The series 
of animated tutorials made all possess a similar overall visual scheme with little 
deviation.  The second step in this process was to pick out the illustratable parts of the 
script and determine how to best portray it, a step which included initial drafting of 
motion and animation schemes.

Media

After the “storyboard” was determined desirable it was time to begin collecting and 
creating the various forms of media.  Vector graphics, graphics drawn by the computer 
from a mathematic model (as apposed to raster graphics like a photograph), were most 
often created from within Keynote using the “Insert->Shape” dialog in the menu bar.  
Similarly, vector graphs and charts were used in one case using the “Insert->Chart->3D 
Line” dialog.  Shapes, which include a variety of primitive geometries as well as lines 
and free form bezier curves, were combined together and formatted to produce more 
complex shapes and forms.  General parameters for shapes include Fill (none, color, 
gradient, advanced gradient, image, and tinted image), Stroke (none, line, and picture 
frame), Shadow, Reflection, and Opacity, all of which can be controlled using the “View-
>Show Inspector” interface window under the “Graphic” tab, as well as Size, Position, 
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and Rotate, all of which can be controlled using the “View->Show Inspector” interface 
window under the “Metrics” tab (see Figure 2).

 Figure 2. Keynote Inspector: Graphic & Metrics Tabs

High resolution photographs used were taken with a Canon PowerShot S3 IS camera at 
6 mega pixels.  Any enhancement of images was conducted using a free photo 
management, editing, and sharing software, “Google Picasa” (available for MacOS 
10.4.9+ (Intel Only), Windows XP/Vista, and Linux at http://www.google.com/picasa) 
or using Keynote’s built in “View->Show Adjust Image” interface window.  Most 
parameters for vector graphics in keynote are available for photographs.  Photographs 
of the various waste disposal units in Salisbury Labs 223 were prominently featured in 
the Waste Management animation.

In some cases where the use of highly conserved graphics was desired, such as with the 
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collection of hazard symbols and signs used in the Laboratory Safety animation, 
searches for high resolution vector and raster graphics were conducted online using 
search tools provided by google at http://www.google.com, http://
images.google.com, and http://www.wikipedia.org.  Wikipedia and the Wikimedia 
Commons were consulted most frequently, as many of the graphics available are in a 
vector graphics format (Scalable Vector Graphic, .svg) and are provided under public 
license by their contributers.  It should be noted that, though vector graphics are most 
desirable as they can be resized without a loss in quality, Keynote does not understand 
the most common format, Scalable Vector Graphic.  As a result, all SVGs were converted 
to high resolution Portable Network Graphic (.png) images using the open source 
vector graphics application, Inkscape (available for MacOS 10.3+ (Universal), Windows 
XP/Vista, and Linux at http://www.inkscape.org).

Video used was filmed in Salisbury Labs 223 in Digital Video format (DV) using a 
Canon 3CCD GL 2 Video Camcorder and tripod.  Footage was then transferred from 
miniDV tape to first generation Apple MacBook 1,1 via FireWire 400 interface using 
iMovie ’09.  iMovie ’09 was used to trim and enhance the video picture, and add 
stabilization where necessary when a tripod wasn’t used.  Video footage of the bubble 
blowing procedure was featured in the animated tutorial, “Bubble Blowing”.

Music was used in one animation, “Laboratory Safety,” for background.  The piece, 
“Let’s go Shopping,” by Jerry Martin, was chosen for its lack of lyrics, subtle 
background quality, and humorous retro informercial sound.  The music was written 
and performed by Jerry Martin, and permission from him to use the piece in the 
animation was necessary.  Permission was requested and granted via email.

Animation Development

With media "in hand", the elements could be put together in a time based structure that 
would ultimately form the final animated tutorial.  In Keynote, the key frames from the 
story board were recreated as presentation slides.  After putting the storyboard into a 
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working series of slides, they could begin to be animated.  Depending on the 
complexity of the animation produced, some slides were broken up into sub slides with 
different groups of animation actions on each slide, while other slides were combined 
into a single slide if the animation desired required the elements to be on the same slide.  
This sort of decision could only be made on a case by case basis depending on the 
desired actions of slide elements.  Music and sound also play a role in how slides were 
organized, as music and sound cannot cross between slides except for an single 
background track which will play for the entire length of the animation and repeats 
itself until the animation ends.

In general, there are three different types of animation: slide transitions, entrance and 
exit animations, and actions.  Transitions, as they are so rightly named, are the animated 
effects applied between slides as one transitions to the next.  The transitions can be as 
simple as a cross dissolve or fade (referred to as "Dissolve" by Keynote) or as complex as 
3D movement of objects on both slides or of whole slides.  Consistency in any single 
tutorial was maintained, using only a select few transitions throughout any single 
presentation to give an overall consistency, using a certain transition specifically for 
moving from one section to the next with another specifically for the initial opening of 
the tutorial, and more professional look.  Ergo, the use of "Random" as a transition 
option was always avoided.  Transition effects are accessible in the Inspector under the 
Slide tab (see Figure 3).
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Figure 3. Keynote Inspector: Slide & Document Tabs

Entrance and exit object transitions, referred to as "Build In" and "Build Out" by 
Keynote, were used to bring or remove objects to and from the field of view (i.e. the 
slide).  Many of these effects are similar to transitions, such as the "Dissolve" effect, but 
instead of applying to a slide or all the objects on a slide they apply to a single object, 
such as a text box or an image, or a group of objects.  As with the transitions, 
conservative use of these effects was important for giving a professional presentation.  
Any object, or group of single objects forming a larger more complex object, can be 
given any number of these animation schemes over time.  While the specific options 
vary between these builds, they all have a given "Duration" and "Order".  Each build 
can be set to occur after the previous build has completed or while the previous build is 
executing, and each can be delayed by a specified time in seconds.  These "Build In" and 
"Build Out" effects are accessible in the Inspector under the Build tab (see Figure 4).
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Figure 4. Keynote Inspector: Build Tab with Build Order Drawer Opened

The movement and alteration of objects on a slide over time (the closest thing to true 
animation controlled by the artist), using what Keynote refers to as "Actions", was 
necessary in certain cases where the animation of objects could not be achieved by 
"Build In"/"Build Out" transitions alone.  "Actions" can be applied to any object or 
group of objects and include "Movement", "Scale", and "Opacity".  Like the builds, 
actions have a specified duration and delay.  Staring with Keynote '09, the "Magic 
Move" slide transition was implemented.  This transition detects objects that repeat 
from one slide to the next and automatically calculates the movement to transition those 
objects from their position on the first slide to their position on the second slide.  This 
new transition was used instead of the "Movement" action where it could be, as it is 
faster and simpler to use.  The "Actions" are accessible with "Build In" and "Build Out" 
in the Inspector under the Build tab (see Figure 4 above).
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Sound was used in the tutorials for narration and, in one instance, music.  Music 
intended to play continuously in the background was not applied to any single slide but 
to the document as a whole in Audio under the Document tab in the Inspector dialog 
(see Figure 3 above).  Other sounds, including narration, was imported (or dragged) 
directly to a given slide.  An audio object is controlled using the "Build In" and "Build 
Out" and is a part of the same build order as the animation builds and actions.  Because 
background audio is the only audio capable of spanning multiple slides, audio desired 
to cross from one slide to the next was split into multiple files (see more in Narration 
Synthesis section below).

Narration Synthesis

Narration for these animations was synthesized using a computer voice introduced by 
Apple, Inc. with Mac OS 10.5 Leopard named Alex.  Alex was chosen as a voice for its 
advanced and relatively realistic speech compared to its predecessors.  The voice even 
takes breaths.  As advanced as it is, it nonetheless does not always speak in a manner 
that is natural.  This can be humorous, but for certain scientific names and words it was  
important that the voice speak them correctly.  This was achieved by altering the 
spelling of words in the narration text to trick the voice into speaking words correctly.  
For example, “pipetting” became “pi-petting” and “Vibrio fischeri” became “Vibbrio 
Fisher-ay”.  Any text desired to be heard spoken by Alex could be previewed in TextEdit 
by selecting “TextEdit->Services->Speech->Start Speaking Text”.  The voice “Alex” must 
be selected as the computer speech voice in System Preferences under the “Speech” 
preference pane. A sample script is available in Appendix B.

Once the narration bugs were worked out and Alex spoke in a manner desired, the 
speech needed to be saved as an audio file on the computer before it could be added to 
the animation.  This was accomplished by creating a small applet that took some text 
and saved it as audio using the desired voice.  The applet, dubbed “Speak it & Save it” 
was created as an Automator Workflow and runs through Automator to allow for 
maximum control and customization.
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Because Keynote operates in a slide-to-slide manner, audio cannot easily be made to 
play while transitioning from one slide to another.  Therefore, the narration was broken 
down into pros or smaller segments and converted to separate audio files as such.  In 
this way, the timing for the narration could be more precisely controlled and the 
narration as a whole could span from slide to slide.  After adding the audio clips into 
the animation scheme, timing often had to be slightly adjusted to allow for more or less 
time in order to synchronize the animation with the newly added speech.  In some cases 
where it was necessary to have speech span a slide transition, the audio file was added 
the rendering of the tutorial by injecting it into the raw video file at the desired time.  
The technique for this used Apple Quicktime Pro, which allows for addition and 
subtraction of as many video or audio tracks as desired at any time in the timeline 
without the need to re-render the original data, resulting in no loss of quality and no 
addition render time. 

Video Rendering

Video rendering was initiated only after a final play through of the animation to verify 
that all timing was correct.  Once verified, settings were selected in the Export interface 
at File->Export for Manual Advance, Full Quality, Include Audio, and Include 
Transparency (see Figure 5).  Parameters for rendering could be customized further, but 
Full Quality was found to be sufficient.  After rendering the video it was opened using 
Apple Quicktime Pro to remove the Sprite track (so the video would advance on its 
own), enable the playback controls, and to play through once again in order to check for 
improper timing with narration (it was found that the timing isn’t always the same after 
rendering).  If any discrepancies appeared, then adjustments were made in the original 
project data and the animation was rendered and checked again.
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Figure 5. Keynote Export Interface.

Once the animation was fully finalized, a version needed to be exported to Windows 
Media Video format, though less desirable as it lacks in quality per bitrate, in order to 
be played back using WPI’s Windows Media Streaming Server.  Conversion was carried 
out using Flip4Mac plugin for Apple Quicktime Pro. The parameters given by WPI’s 
Academic Technology Center are as follows:

Codec: Windows Media Video 9, Windows Media Audio 9.2
Size: 640x480, Square Pixels (Progressive)
FPS: 29.97
One Pass, Constant Bit-rate
Max Bit-rate: 600kbps
Keyframe Interval: 20
Audio Format: 32kbps, 44kHz, Stereo (A/V) CBR

Uploading to Intranet

Finished animated tutorials were uploaded to WPI's Windows Media Streaming Server 
at media.wpi.edu via server message block network protocol (smb://media.wpi.edu) 
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using Finder's "Go -> Connect to Server..." function in Mac OS X.  Files followed the 
proper naming convention: all lowercase characters, no spaces, underscores.

Survey of Students

Students of the BB903 C09 lab course were surveyed with 15 Likert-Scale, closed-ended 
questions and 7 open-ended questions designed to gather students feedback on the 
educational value and quality of the tutorials, the use of animation versus live action, 
and recommendations for future tutorials.  The survey was administered on paper 
during Monday lecture on paper.  Candy was offered to students in exchange for filling 
out the survey as incentive.  See Appendix A for survey questions.
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RESULTS

The following results were compiled from a survey administered to BB2903 C09 by 
Connected Lab IQP teams.

Quality of Videos

In assessment of the tutorials' quality, 83 students (95%) agreed or strongly agreed that 
spoken word in the tutorials was spoken clearly, 63 students (72%) disagreed or 
strongly disagreed that featured background music was distracting, and 80 students 
(92%) felt the computer synthesized voice, Alex, was audible and clear (see Figure 6).
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Figure 6. Questions Pertaining to Tutorial Quality from IQP Team Survey of Students: question 5, “the 
audio associated with the videos were clear/audible”; question 12, “the background music in the 
animated video is distracting”; question 13, “the computer voice, Alex, is audible/clear.”
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Helpfulness of Videos

In assessment of the tutorials' value or helpfulness, 75 students (86%) agreed or strongly 
agreed that the tutorials aided in their completion of the lab course, 71 students (82%) 
agreed or strongly agreed that they learned and retained more information about the 
lab procedures by watching the tutorials, 71 students (82%) agreed or strongly agreed 
that they where more comfortable performing in lab after viewing the tutorials, and 80 
students (92%) agreed or strongly agreed that these tutorials were a helpful supplement 
(see Figure 7).
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Figure 7. Questions Pertaining to Tutorial Helpfulness from IQP Team Survey of Students: question 2, “I 
believe the videos aided me in effectively completing the current lab”; question 3, “I learned and retained 
more information about the lab procedures by watching the videos”; question 4, “I was more comfortable 
performing in lab after watching the associated videos”; question 9, “the videos were helpful as a 
supplement.”
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Student Stats

In assessment of student stats, comparing final grades earned to whether or not 
students viewed the tutorials prior to lab, the results indicate that students who made 
use of the tutorials prior to lab sessions performed better academically:  of students who 
felt they would receive an A (17, 37% of students answering), 12 (80%) agreed or 
strongly agreed that they viewed the tutorials prior to the lab section; of students who 
felt they would receive an B (17, 37% of students answering), 11 (65%) agreed or 
strongly agreed that they viewed the tutorials prior to the lab section; of students who 
felt they would receive an C (4, 9% of students answering), 2 (50%) agreed or strongly 
agreed that they viewed the tutorials prior to the lab section; of students who felt they 
would receive between and A and B (2, 4% of students answering), 1 (50%) agreed or 
strongly agreed that they viewed the tutorials prior to the lab section.  1 student 
reported expecting to receive an NR (F equivalent) and 5 choose not to respond (see 
Figure 8).  Of students who indicated they had taken a BB2900 lab course prior to 
BB2903 C09, 73% felt that they required less help from the lab TAs for this course 
compared to previous courses (see Figure 9).  69% of students agreed or strongly agreed 
that they attended lecture (see Figure 10).
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Figure 8. Questions Pertaining to Student Statistics from IQP Team Survey of Students: (A) Student 
Grades Against Responses to Survey Question 1 (top), if students watched tutorials prior to going to the 
lab.
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Figure 10. Responses to Survey Question 6 (bottom), if students attended lecture.

Additional Feedback

93% of students agreed or strongly agreed that video technology used for BB2903 C09 
should be implemented in other biology labs at WPI, 84% of students disagreed or 
strongly disagreed that the tutorials where unnecessary, and when asked if animated 
tutorials where easier to watch, 51% disagreed or strongly disagreed while 40% agreed 
or strongly agreed (see Figure 11).
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Figure 11. Questions Pertaining to Student Feedback: question 11, “this video technology should be 
implemented in other biology labs at WPI”; question 10, “the videos were unnecessary”; question 14, “the 
animated videos were easier to watch than just video demonstrations.”

Open Response

The Connected Lab IQP team survey also featured an open response section with a 
series of questions, the most pertinent of which described here.  In the short answer 
section of the survey when asked what was most liked about the video tutorials, 49% of 
students answered that it was the step by step nature of the tutorials and only 5% 
answering that they never watched the videos.  When asked what was particularly 
disliked about the videos, 30% of students who answered (22% total) indicated the 
videos were too long.  When asked whether or not there were videos/animations they 
felt would be better as one or the other, 45% of students didn't answer but 37% of 
students indicated they preferred an actual demonstration as apposed to an animated 
one, 11% felt they were good as they were, and 3% indicated "yes" but did not specify 
anything further.  When asked how the tutorials were most beneficial, for quizzes, 
laboratory reports, or understanding and retaining material, 47% of students who 
answered indicated understanding and retaining the material, with 22% indicating lab 
reports and 24% indicated that they were most useful while in lab.  For the full set of 
questions and their tallied answers, see Appendix A.
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Additional data, including final student grades and hit counts (the number of times 
each of the tutorials were accessed), is also available in Appendix A.
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DISCUSSION

The educational value of these tutorials in teaching laboratory assays and techniques is 
rather certain, and the cessation of their development and use is not recommended.  
Responses to the administered survey show that 82%+ of students agreed that the 
tutorials aided in their completion of the lab course, that they learned and retained 
more information about the lab procedures, and that they where more comfortable 
performing in lab after viewing the tutorials; 92% of students agreed or strongly agreed 
that these tutorials were a helpful supplement (see Figure 7 in Results).  Hit count 
records show that students accessed some of the videos over hundreds, sometimes 
thousands, of times, especially for the more complicated dissection procedures (see 
Appendix A). Students who watched the tutorials performed better in the course 
overall, feeling they would receive higher grades than those students who did not 
watch the tutorials (see Figure 8 in Results).

Additionally, the majority of students (92%+) were relatively pleased with the quality of 
the tutorials, having no difficulty in understanding the spoken word, both recorded and 
synthesized, used for narration.  Most students (93%) also agreed that the use of these 
tutorials should be expanded to other biology labs.  In the search to enhance laboratory 
education, the Connected Laboratory Project has certainly found a medium, these video 
tutorials, to assist instruction of students both outside of the laboratory and within it.

Specifically regarding the use of animated tutorials, preference to watching an animated 
instruction over live action was split near fifty-fifty with the slight minority preferring 
animation.  In the open response section, when asked whether or not certain tutorials 
would be better animated or live action, 45% of students didn’t answer but 37% 
indicated that they preferred a live action demonstration of procedure and protocol.  
While 37% is not the majority of students, it is a large enough percentage that, coupled 
with the fact that no students indicated that they preferred animation over live action, 
this input should be considered.  The congruence principle by Tversky et al. (2002), as 
described in the introduction) says that the more realistic presentation facilitates better 
learning, and since little is more real than live action, this preference makes sense. 

24



Therefore it is suggested that the use of animated tutorials be kept to non procedural 
demonstrations, as featured in “Lab Safety” and “Waste Management”, to topics where 
live action would be inappropriate, such as microscopic or molecular settings as 
featured in “Quorum Sensing”, or to be used in conjunction with live action as an 
instructional supplement as featured in “Bubble Blowing”.  This third and final model, 
hybrid tutorials where live action is supported with computer animation, may be the 
most powerful option, providing students with a systematic breakdown of procedure 
and action where it may be visually confusing with live action while still providing real 
examples.  This would, in turn, create the most complete model tutorial which caters to 
the greatest breadth of students with diverse learning styes and preferences, and would 
comply with the congruence principle to facilitate optimal learning.  This model is 
therefore recommended for future tutorial development.

Though the reason for choosing Apple’s Keynote software stems from the following 
facts, (1) Keynote provides good control over actions and animations and has a wide 
range of presets and (2) Keynote can export directly to a host of video file formats, it is 
the experience of the developers/authors that Keynote, while powerful, it falls short 
more than anticipated. Developing certain animated tutorials using Keynote proved 
especially tedious and difficult, the best example of this being “Quorum Sensing,” 
which features especially dynamic characters and interactions.  “Quorum Sensing” 
could not be properly completed with Keynote alone.  Therefore it is recommended by 
this team that further computer animation development be done with software actually 
designed for this purpose. Keynote does have a relatively short learning curve and 
certainly if professors or students wanted to contribute material, Keynote or other 
presentation softwares are still decent options. To “do it right”, however, it is better long 
term and will be more flexible for core development teams if such true animation 
software is used.  WPI provides access to Adobe Flash on select campus computers and, 
now, the proper training is available from WPI’s Academic Technology Center.  A 
noteworthy alternative to Adobe Flash is the free open source software packaged, 
Synfig Studio, available at www.synfigstudio.com.  While not as powerful or fully 
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featured as Adobe Flash, it provides a free option for institutions other than WPI 
without Flash and the funding to acquire it.

As a final note, the use of Adobe Flash or Synfig Studio lends themselves to the 
development of interactivity within the tutorials, live action or animated. Though 
students already have access to playback controls with all the video tutorials, additional 
interactivity would allow for devision of material into relevant segments, giving 
students a more organized presentation and additional control of pace and reducing the 
effects of unwanted cognitive load (Arguel & Jamet, 2009).  Additionally, further 
exploration of interactivity may facilitate further learning options, such as requesting 
student input or action in the virtual “laboratory” such a tutorial would provide.  
Interactivity within these video tutorials provides the next dimension in laboratory 
education as a part of the Connected Laboratory Project. 
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APPENDIX A: EXTENDED DATA

Survey Data

strongly 
agree

agre
e

disagre
e

strongly 
disagre
e

N/
A

Total

question 1 13 45 18 10 1 87

question 2 31 44 8 3 1 87

question 3 24 47 15 1 0 87

question 4 33 38 13 3 0 87

question 5 39 44 4 0 0 87

question 6 37 23 20 7 0 87

question 7 10 20 34 20 3 87

question 8 6 13 43 22 3 87

question 9 32 48 4 0 3 87

question 10 3 10 39 34 1 87

question 11 26 55 4 1 1 87

question 12* 1 18 55 8 5 87

question 13 21 59 3 1 3 87

question 14 7 28 43 2 7 87

question 15** yes no Total:

46 25 71

2901 2902 2904
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33 27 17

yes no no response 
(answered no to first 
part)

no response 
(answered no to first 
part)

no response 
(answered no to first 
part)

40 15 323232

*question 12: one student marked an x between agree and disagree - this was tallied into 
the disagree column.
**question 15: two students had not taken other labs but marked that they required less 
assistance than in other labs. Tally was placed instead under "no response"

IQP Team Survey Closed-Ended Questions

1. I watched the videos prior to coming to lab.

2. I felt that the videos aided me effectively in completing the current lab.

3. I learned and retained more information about lab procedures by watching 
the videos.

4. I was more comfortable performing in lab after watching the associated 
video.

5. The audio associated with the videos were spoken clearly.

6. I always attended the lecture.

7. The appearance of Gompei enhanced my interest in the videos.

8. The presence of Gompei helped me remember the lab protocol more.

9. The videos were a helpful supplement.

10. The videos were unnecessary.
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11. This video technology should be implemented in other biology labs at WPI.

12. The background music in the animated video is distracting.

13. The computer voice, Alex, is audible and clear.

14. The animated videos were easier to watch than just the video demonstrations.

15. Have you taken other BB290X labs?  (Yes, No)
If yes, which ones have you taken? Circle all that apply.  (BB2901, BB2902, 
BB2904)
Did you feel you required less assistance from the TAs after watching the 
videos than in previous 2900 labs?  (Yes, No)

*Questions 1-14 are likert-scale: Strongly Agree, Agree, Disagree, Strongly Disagree.  
Question 15 is multiple choice with specific answers in parenthesis.

IQP Team Survey Open Response Questions and Tallied Answers

1. What did you particularly like about the videos?
• No answer 

i. 11
• Thorough and clear

i. 13
• Visual demonstration/ Helpful with dissection 

i. 15
• Step by step instructions(specific)/procedure/protocol 

i. 26
• Well paced

i. 1
• Well constructed

i. 2
• Animation

i.  1
• Follow while doing lab 

i. 4
• Needed TA less

i. 1
• Easy to Follow

i. 1
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• Ahead of time help/availability
i. 5

• Narration 
i. 2

• Summary at end
i.  1

• Showed what to do and what tools looked like
i. 2

• Didn’t watch any, no opinion
i. 4

• They Exist
i. 1

• Easy to Access
i. 1

•Nothing
i. 1

• Good Supplement to other materials
 1

• Alternative to reading
 2

2. What did you particularly dislike about the videos?
• No answer

i. 23
• Nothing

i. 14
• Slow 

i. 11
• Fast

i. 1
• No location of materials

i. 1
• Awkward timing

i. 1
• Quality

i. 6
• Length (long)

i. 19
• Wish could  skip around easier

i. 1
• Naming materials took too long

i. 5
• More detail
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i. 1
• Gompei (Stupid Goat)

i. 2
• Talked too slow

i. 2
• Some videos had poor sound quality

i. 1
• Didn’t watch, no opinion

i. 2
• Trouble Loading/Playing the video

i. 1
• Couldn’t follow dissection with book

i. 1
• They were in 2D

i. 1

3. Any suggestions for future videos? Something you would have liked to see?
• No Answer

i. 36
• Nothing

i. 19
• Don’t list all the materials/procedure or keep it shorter

i. 4
• Better volume control

i. 2
• Separate into sections

i. 3
• Keep concise and similar to lab (no deviations)

i. 3
• Speed up dissections

i. 3
• More text to point out key step

i. 2
• Lines for incisions drawn

i. 1
• Mike cameo (humorous) w/ helpful hints

i. 1
• Label organs better

i. 1
• Podcast

i. 1
• Explanation of expected results

i. 1
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• Close-up shots of more things (i.e. well plate vs. strip for ELISA)
i. 1

• Spend more time on how to make initial cuts
i. 1

• More animations
i. 1

• Less monotonous voices
i. 1

• Overview at beginning and recap at end
i. 1

• Better editing
i. 1

• Faster
i. 1

•More discussion while dissection
 1

o Film in smell-o-vision
 1

• Use a standardized format for the videos
i.      1

o Have several file formats available to open
1

4. Are there any videos you feel would be better understood as an animated video? (or vice 
versa)

• No Answer
i. 39

• No – Good as they were
i. 10

• No (prefer actual demonstration)
i. 32

• Yes (No indication to which)
i. 3

• See what’s happening at molecular level (?)
i. 1

• Animated images of wells
i. 1

• Fetal Pig Dissection
i. 1

• Background information on related topics
i. 1

• Show what you should see under microscope / label and point things out
i. 1
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• Any that involve small instruments
i. 1

• ?
i. 1

5. What do you think the video helped more; quizzes, laboratory reports, or understanding 
and retaining material?

• No answer
i. 16

• Understanding and retaining material
i. 37

• All the above
i. 3

• Quizzes
i. 2

• Laboratory reports (procedures)
i. 17

• Quizzes and Lab Reports
i. 1

• Help while doing lab
i. 19

6. What grade do you expect to receive?
• A

i. 42
• Between A and B

i. 2
• B

i. 29
• C

i. 8
• NR

i. 1
• No Answer

i. 7
• Don’t know

i. 1

7. Other Comments?
• No Answer

i. 66
• No

i. 5
• God help me
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i. 1
• Good Job

i. 6
• Didn’t work on a MAC (didn’t watch until lab)

i. 1
• Didn’t watch Labs 5 & 6 because of time management problems

i. 1
• More videos in Bio classes, good way to teach and learn

i. 1
• “The videos are great, and I felt so much more comfortable using them in lab. 

Please make them for the D-term BB2000 level labs!!”
i. 1

• Did not watch the videos
i. 1

• Candy is a big motivator
i. 1

• Interesting supplement to lab
i. 1

Grades

Grades are displayed as points (left) and letter grade (right).

Total|100160 Grade

240.5 NR

479.75 A

497 A

440.75 B

439.75 B

485.15 A

490.25 A

0 NR

490 A

397.25 C

495.75 A

470.25 A

473.5 A

405.75 C
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488.25 A

415 B

492.25 A

321.25 NR

462.25 B

381.5 C

342.5 NR

469.75 A

468.25 A

489 A

411.25 C

506 A

404.5 C

407.25 C

379.5 C

436.75 B

448.8 B

484.25 A

511.65 A

498.5 A

447.75 B

462.25 B

476 A

165.15 NR

462.45 B

476.5 A

408.75 B

473.75 A

485.5 A

432 B

479.5 A

430.25 B

403.75 C

375 C

40



482.25 A

497.5 A

459.5 B

239.75 NR

468.75 A

495.4 A

222.75 NR

311.75 NR

481.5 A

469.75 A

432.75 B

488.75 A

18 NR

395.25 C

486 A

485.5 A

375.25 C

484.8 A

382 C

456.5 B

481.5 A

331.5 NR

429.5 B

208.5 NR

210 NR

395.35 C

460.5 B

495.25 A

462.05 B

418 B

354.6 NR

466.75 A

455.95 B

469.95 A
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350.75 C

488.5 A

485.9 A

108 NR

465.5 A

482.4 A

413 C

491.5 A

451.95 B

428.75 B

417.75 B

425.75 B

481 A

477.25 A

421.5 B

463.75 B

Number of Requests Sent for Online Tutorials (Hit Counts)

Tutorial Directories on Media Server Total Peak*
/Academics/Depts/Bio/ConnectedLab/BB2903/amoeba_slides.wmv 457 244
/Academics/Depts/Bio/ConnectedLab/BB2903/dialysis_tubing.wmv 298 177
/Academics/Depts/Bio/ConnectedLab/BB2903/diffusion_plates.wmv 326 152
/Academics/Depts/Bio/ConnectedLab/BB2903/elisa.wmv 223 125
/Academics/Depts/Bio/ConnectedLab/BB2903/euglena_slide.wmv 286 184
/Academics/Depts/Bio/ConnectedLab/BB2903/lime+water_breath.wmv 35 21
/Academics/Depts/Bio/ConnectedLab/BB2903/micropipeNors.wmv 221 137
/Academics/Depts/Bio/ConnectedLab/BB2903/onion_plasmolysis.wmv 191 114
/Academics/Depts/Bio/ConnectedLab/BB2903/phalanges_measurement.wmv 1 1
/Academics/Depts/Bio/ConnectedLab/BB2903/phenothalein_breath.wmv 36 20
/Academics/Depts/Bio/ConnectedLab/BB2903/pig_disecOon.wmv 2632 233
/Academics/Depts/Bio/ConnectedLab/BB2903/Pig_dissecOon_Chapter1.wmv 164 100
/Academics/Depts/Bio/ConnectedLab/BB2903/Pig_dissecOon_Chapter2.wmv 207 90
/Academics/Depts/Bio/ConnectedLab/BB2903/Pig_dissecOon_Chapter3.wmv 922 105
/Academics/Depts/Bio/ConnectedLab/BB2903/Pig_dissecOon_Chapter4.wmv 310 85
/Academics/Depts/Bio/ConnectedLab/BB2903/Pig_dissecOon_Chapter5.wmv 59 29
/Academics/Depts/Bio/ConnectedLab/BB2903/Pig_dissecOon_Chapter6.wmv 27 17

42



Tutorial Directories on Media Server Total Peak*
/Academics/Depts/Bio/ConnectedLab/BB2903/Pig_dissecOon_Chapter7.wmv 105 65
/Academics/Depts/Bio/ConnectedLab/BB2903/Pig_dissecOon_Chapter8.wmv 66 25
/Academics/Depts/Bio/ConnectedLab/BB2903/potato_staining.wmv 277 163
/Academics/Depts/Bio/ConnectedLab/BB2903/safety_corner.wmv 261 149
/Academics/Depts/Bio/ConnectedLab/BB2903/Sequence+01.wmv 3 2
/Academics/Depts/Bio/ConnectedLab/BB2903/sequence_amoeba.wmv 1 1
/Academics/Depts/Bio/ConnectedLab/BB2903/sequence_squamous_cell.wmv 10 8
/Academics/Depts/Bio/ConnectedLab/BB2903/serial_diluOons.wmv 1 1
/Academics/Depts/Bio/ConnectedLab/BB2903/squamous_cell_sOaning.wmv 267 160
/Academics/Depts/Bio/ConnectedLab/BB2903/using_spirometer.wmv 53 29
/Academics/Depts/Bio/ConnectedLab/BB2903/yeast_budding.wmv 250 158
/Academics/Depts/Bio/ConnectedLab/general/lab/lab‐trash.wmv 4 3
/Academics/Depts/Bio/ConnectedLab/general/lab/lab_safety.wmv 4 2
/Academics/Depts/Bio/ConnectedLab/general/LabSafety/lab_safety.wmv 4 2
/Academics/Depts/Bio/ConnectedLab/general/Microscopy/using‐a‐microscope.wmv 371 200

*peak refers to the highest number of hits per single day.
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APPENDIX B: SAMPLE SCRIPT

• sample script of “Survivorship Curve” animated tutorial:

Welcome to "Connected Lab at W.P.I." video tutorial on "Survivorship."

Section 1: Types of Survivorship

Survivorship Curves visually depict age-specific mortality through survivorship.  
Any such curve is obtained by plotting the number of individuals of a particular 
age group against time.  Conventional graphing methods plot the logarithms of 
survivor number against age.  Any such survivorship curve can be classified into 
at least 3 types.

Type 1 Survivorship curves are convex and illustrate species with high 
survivorship whose members most often liv out the majority of their lifespan.  
Certain plants and mammals tend to follow this trend, most notably Human 
Beings.

Type 2 Survivorship curves are linear and illustrate species with relatively 
constant mortality rates.  Many reptilian species, corals, and the honey bee follow 
this trend.

Type 3 Survivorship curves are concave and illustrate species with high mortality 
rates in early life.  Most species with large numbers of offspring, such as 
invertebrates and fish, follow this trend.

Now we have learned the 3 primary survivorship curves.  Isn't this fascinating?

Thank you.
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